EEG Preprocessing

Importing data, rejecting data, and performing ICA decomposition

EEGLAB Workshop XX
Sheffield, England
Day 1, 14:00-15:30
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Installing EEGLAB and data folder

 Start Matlab
« Add the EEGLAB folder to your Matlab path:

4\ MATLAB R2013b ==

- G RS -

= New Variable Analyze Code '7 Community
E ED] (b [E Find Files l&l E = lj @ {0} Preferences U -
_ @ Open Variable ¥ éf Run and Time ‘:9 Request Support
New New Open || |Compare Import Save - : Layout (5] set Path Heb
Script v v Data Workspace [/ ClearWorkspace v [’ Clear Commands v v O Add-Ons
FILE VARIABLE CODE ENVIRONMENT RESOURCES
@ = 8 L » C» Users » marissa » Documents » MATLAB v
Command Window (O Command History ®
mexrp—oTimoop
(‘\ . . - -
| (1) New to MATLAB? Watch this Video, see Examples, or read Getting Started. X||&-2-- 11/14/2013 5:45
fx >> addpath('C:\Program Files\MATLAB\R2013b\eeglabll 0 5 4b'); eeglab

~EEG.history
eeg_eventtypes

~eeg_eventtypes (EE
i ~eeglab redraw

m©
a0

-- 11/15/2013 8:34
~eeglab
EEG.history

m

~EEG.comments
-~ EEG.history
| EEG

1

$-- 11/15/2013 11:1:

<l »

‘| Ready

N =
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The EEGLAB Matlab software

main graphic interface

[ 4\ MATLAB R2013b (o[ E 3]
M T -

(4}1' CDJ ™y (S FndFies & E [z, New Variable | Analyze Code E @ pref u (*%§ Community
i = eferences

v =
New New Open l&‘ e P @ Open Variable éf Run and Time Layout @ S Help Request Support
Script v - Data Workspace [/ Clear Workspace v [/ Clear Commands ~ - v [ JAdd-Ons v
FILE VARIABLE CODE ENVIRONMENT RESOURCES
@ 5% L » C» Users » marissa » Documents » MATLAB P
© X
Current Folder Y Command Window n EEGLAB VIIOSQ -19
Name « @) New to MATLAB? Watch this Video, see Examples, or read Getting Start - —
7] pathdef.m £ >> eeglay File Edit Tools Plot Study Datasets Help ~
! No current dataset
" - Create a new or load an existing
Use "File = Import data" (new)
Or "File = Load existing dataset" (old)
\ - If new.

"File = Import epoch info" (data
\ "File = Import event info" (continuous
"Edit = Dataset info" (add/edit dataset
"File > Save dataset" (save dataset)
- Prune data: "Edit > Select data"
- Reject data: "Tools = Reject
' - Epoch data: "Tools > Extract epochs"
- Remove baseline: "Tools = Remove
-RunICA: '"Tools = Run ICA"

I1/ 137201 .39 LIl &

Details A |

Ready
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“Secrets” to a good ICA decomposition
-

| r

\ \\%’;»_, Newsescunce

» Garbage in... garbage out (it's not magic)

» Remove large, non-stereotyped artifacts

» Do you have enough data? (based mostly on time, not frames)

» High-pass filter to remove slow drifts (no low-pass filter needed)

» Remove bad channels

» Data must be in double precision (not single)
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The Goal of Preprocessing

Create a complete EEG:AB data set with
— EEG

— Channel Locations
— Events

Preprocess the EEG data to yield optimal ICA
decompositions

— Rereferencing

— High Pass Filtering

— Remove bad channels, noisy segments of data

Run ICA decomposition

— Then go to my previous lecture...Evaluating ICA Components
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Many Preprocessing Variants

%

Resources
— EEGLAB wiki “Quick Tutorial on Rejection”
 http://sccn.ucsd.edu/wiki/Quick Rejection_Tutorial

— Makoto’s Preprocessing Pipeline
 http://sccn.ucsd.edu/wiki/Makoto%27s_preprocessing_pipeline

— Bigdely-Shamlo et al (2015): PREP Pipeline
 http://dx.doi.org/10.3389/fninf.2015.00016

— EEGLAB Plugins
« Kothe's clean_rawdata plugin
« Miyakoshi’s trimQutlier plugin
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Examine raw data

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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Importing a dataset

Newrescunce

From ASCIl/float file or Matlab array

From Netstation .mff (FILE-IO toolbox)
From Netstation binary simple file
From Multiple seg. Netstation files
From Netstation Matlab files

From BCI2000 ASCII file

From Snapmaster .SMA file

From Neuroscan .CNT file

From Neuroscan .EEG file

From Biosemi BDF file (BIOSIG toolbox)
From Bicsemi BDF and EDF files (BDF plugin)

/From EDF/EDF+/GDF files (BIOSIG toolbox)

From ANT EEProbe .CNT file
From ANT EEProbe .AVR file

B £EGLAB v110.5.4b
File | Edit Tools Plot Study Datasets Help
Import data ) Using EEGLAB functions and plugins
Import epoch info ) Using the FILE-IO interface
Import event info ) Using the BIOSIG interface
Export ) Troubleshooting data formats...
sz SAISUNY udlaser (uia
Load existing dataset ’
Save current dataset(s) h info" (data
Save current dataset as info" (continuous
Clear dataset(s) 0" (add/edit dataset
"
Create study » (save dataset)
- > Select data"

Load existing study > Reject

I Save current study > Extract epochs"
Save current study as : "Tools > Remove
Clear study 3 > Run ICA”
Memory and other options
History scripts »
Quit

Tip for Biosemi users:
Use the ‘BDF plugin’ version
of the Biosemi BDF/EDF importer

From BCI2000 .DAT file

From BIOPAC MATLAB files

From Brain Vis. Rec. .vhdr file

From Brain Vis. Anal. Matlab file

From CTF folder (MEG)

From ERPSS .RAW or .RDF file

From INStep .ASC file

From 4D .mdd pdf file

From Procom Infinity Text File
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Imported EEG data
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ket

B EEGLAB v11.0.5.4b ——

Comments and dataset history

n Read/Enter comments -- pop_comments()

File | Edit | Tools Plot Study Datasets Help

Dataset info

Event fields

Event values

About this dataset

Channel locations

Select data
Select data using events

Select epochs or events

i Copy current dataset
Append datasets
Delete dataset(s)

Visually edit events and identify bad channels

Udlasel SiZe (i) 204

About this dataset

¥—

Also:
>> EEG.comments

and
>> EEG.history

Data recorded by Marissa Westerfield
Recording date: Oct. 14, 2011

Paradigm:

-Participant looked at fixation box in center of
screen

-Two types of stimuli (outline of a circle, outline
of a star) were presented in the fixation box in
random order

-Participant pressed a button in response to the star

Stimulus codes:

1 = circle

2 = star

3 button press

Recording information:

-reference electrodes were placed on right and left
mastoids (data has already been referenced and the
mastoid channels have been removed)

Processing steps:
high-pass filter - 0.5 Hz
Cleanline applied to 60, 120 Hz

oment | e |
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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Import data events

/"

N

B EEGLAB v11.0.5.4b =RECL X
File | Edit Tools Plot Study Datasets Help N [ .
 Import events from Matlab array or ASCII file
Import data 4|}
Import epoch info » | °
Import event info ' From Matlab array or ASCII file \ / e Import from Presentatlon event flle
Export ) From data channel . .
- . . * Import events from E-Prime eventfile
Load existing dataset From Presentation .LOG file r .
Save current dataset(s) From E-Prime ASCII (ted) file L* Import events from Neuroscan eventfile
Save current dataset as From Neuroscan .ev2 file P, _
Clear dataset(s) ‘OU‘(;OO n Extract event from channel(s) - pop_chanevent() _—_ @E]-?‘_hj
\ Create study » .
- 333.996 Event channel(s) 73
Load existing study unknown
Save current study No (labels only)
Save current study as No Preprocessing transform (data="x) Optional. Ex: X>3
Clear study 25.7 Transitions to extract? (up|down) ' 0 - (click to select)
! Memory and other options Transition length (1=perfect edges) 0 .
History scripts > Assign duration to each events? ] (set=yes)
Quit
Delete event channel(s)? (set = yes) \
Delete old events if any? ’
(Often imported automatically All events of same type? ] L
during data import) Help | Cancel | ok |
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~ Appearance of an event channel in raw data
\{; = Scroll activity — eegplot()

Figure Display Settings Help

Scale
30

4 5 B 7 i 9
Chan. Time Yalue

CLOSE| [Eventtypes| =y =i [ 2 | 5 550 1 sims sasy [ 50 oy
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Imported data events

:Flle Edit Tools Plot Study Datasets Help If event import was

successful,
you will see an
appropriate

number here
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Sample data: basic P300 paradigm

£

Newsescunce

File
SimpleOddball.set

Data
68 channel EEG, 256 Hz sampling rate, Biosemi
system, re-referenced during import to averaged left
and right mastoid electrodes

Task
speeded button press response to star shape (no
response to circle shape), 100 ms presentation
duration, 200 trials
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Import channel locations

Opt. head center
Rotate axis

-17.926
0.51499
80.784
26.133
-4.0011
17.926
-2.698
85

Transform axes

Dataset info
Event fields
Event values
About this dataset
Channel locations
Select data
Select data using events
Select epochs or events
Copy current dataset
Append datasets
Delete dataset(s)

Visually edit events and identify bad channels

Xyz -> polar & sph.
Sph. -> polar & xyz
Polar -> sph. & xyz

Set head radius
Set channel types
Set reference

1 numbe
“nsenchan | << | < |1 | _ > | > | Appendchan |

| Nose along +X il Plot 3D baz)

(Polhemus, BESA, ...)

__Help | _ Cancel | Ok |

use BESA file for 4-shell dipfit spherical model
use BESA file for 4-shell dipfit spherical model —

use MNI coordinate file for BEM dipfit model
Use spherical file with eye channels m “[

e e
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Import channel locations

LEYE
-45.1543
0.54374
0.79487
0.79917
-0.15585
451543
-7.8725

Opt._head center |

Transform axes

Xyz -> polar & sph. [

Sph. -> polar & xyz

Polar -> sph. & xyz

X (rotate X-Z

Set head radius
Set channel types
Set reference

Delete chan

ITE ECE B EEE B
T e sng o] _Pu30000) |
e e T
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B it channel info -- pop_chanedit()

HEOG
-42
0.65556
55.7734
50.2186
-39.9051
42
-28

Opt. head center
Rotate axis

Transform axes

Xyz -> polar & sph.
Sph. -> polar & xyz
Polar > sph. & xyz

Set head radius

Set channel types
Set reference

Delete chan

m--“--
___Plot2D |

| Nose along+X vl _Plot3-D (xyz)
Save (as .ced)

File Edit View Insert Tools Desktop Window Help Ll

DAL KM ARLWOPE LS| 0E | aO

NEHS K ARODRL-E| 08| D

Channel locations

%
%?4895%83 &
PR4

REFRSY F¥]
P




Imported channel locations
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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Re-reference data (if necessary/desired)

| EEGLAB v10

Change sampling rate
Filter the data

_ Re-reference i =

Interpolate electrodes

Re-reference to

(e.g.) 'linked mastoids’

Extract epochs
Remove baseline

Run ICA

Remove compone

RMAS LMAS

__ Ok | - RMAS

- LMAS

Automatic channe

Automatic epoch |

Reject data epochy
Reject data using I

NFT plugin
SIFT

Locate dipales usii

Peak detection usi™

FMRIB Tools
Locate dipoles using LORETA  »

\
\
\
\
\
\
\
\
\
\
\

\
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Re-reference data (if necessary/desired)

Or,

average reference

Change sampling rate
Filter the data

_ Re-reference i =

Interpolate electrodes

Reject continuous

Extract epochs
Remove baseline

Run ICA

Remove compone

Automatic channel

Automatic epoch rf

Reject data epochs

LEYE REYE

Reject data using I
NFT plugin
SIFT

Locate dipoles usin

Cancel [ 0ok

Peak detection using

FMRIB Tools
Locate dipoles using LORETA




On Average Referencing

In theory, positive and negative
current across entire head
should balance—no net current
source or sink: Average
referencing enforces this.

In practice, depends on
distributionofelectrodes.

Averagereferencing reduces
datarank by 1, so you must
remove one channel (Cz often)
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Save new dataset, keep old one

SimpleOddball continuous reref Edit description
. Browse

C \Users\marissalDeskiopEEGLABWordMl___ Brghse |
Cancel || Ok |

Savein: [ || MATLAB ~| « BefE-

File Edit Tools Plot Study Datasets Help N

= | Name ’ Date modified Type
j external 11/10/2009 5:54 AM  File folder
| functions 11/10/2009 5:50 AM  File folder
[ | B plagine 11/10/2009 5:52 AM  File folder
Desktop M sample_data 11/10/2009 5:52 AM  File folder
- | sample_locs 11/10/2009 5:52 AM  File folder

—
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Multiple active datasets (ALLEEG)

—|s(= X
|

=
Dataset 1:SimpleOddball continue
| v ' Dataset 2:SimpleOddball continuo

Select multiple datasets

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA

25



Resample data (if desired)

Reason: Reduce space, time. But keep nyquist and

ICA datalength requirementsinmind...

"B EEGLAB v1L.0.5 20 ™ —( =) |
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Locate dipoles using DIPFIT 2.x

»

File Edit | Tools | Plot Study Datasets Help N
#2: Change sampling rate |hs reref_
Filter the data »

Filen Re-reference

! Char Interpolate electrodes
Framr Reject continuous data by eye
Epoc Extract epochs
Even Remove baseline
g?mm Run ICA
Epoc Remove components
Refe Automatic channel rejection
Char Automatic epoch rejection
Ical:j Reject data epochs »
D Reject data using ICA »

- Resample curr... @M

W TR I

New sampling rate
128 |

Cancel Ok

Help I

26



Remove unwanted channels

Event fields
Event values
About this dataset

Channel locations

Select data

Select data using events
Select epochs of FIY

Copy current da

EXG5 EXG6 EXG7 EXGS
Scroll dataset
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.y,

Pre-processing pipeline

Collect high-density

| into EEGLAB
EEG data (>30 chan) — / mport into EEG

Import event markers
— / and channel locations / _

| | <
. 4 STOP!
Re-reference/ Save your continuous ‘ ) )
Remove line noise
down-sample dataset here _
(if necessary) / (if necessary) _'/
(at leastl)

, \_

Identify/reject | Reject large artifact
bad channels o / time points

—/
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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High-Pass Filter the data

Reason: remove slow, possiblylarge amplitude, drift
EEGLAB V11054 TSNS S| Y Fitte the data - pop_cegfi( (=]

| File Edit [Tools | Plot Stucy Datasets Help s | - edoe of the fecuency ace b
Change sampling rate | \ or odae  froaue e s -
Filter the data Y Basic FIR filter _ e
Re-reference ERPLAB Butterwort
Interpolate electrodes ERPLAB Polynomia High ass
Reject continuous data by eye Short non-linear I} gn-p
Extract epochs ‘

. needed
Remove baseline (
Run ICA |

un for ICA
Remove components ‘
Automatic channel rejection ‘
_Cancel . Ok |
Automatic epoch rejection
]

Reject data epochs » \ EEI™X
Reject data using ICA > ; '

Locate dipoles using DIPFIT 2.x »
Peak detection using EEG toolbox

FMRIB Tools »
Locate dipoles using LORETA »

CleanLine
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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Help

Import data
Import epoch info
Import event info
Export

Load existing dataset
Save current dataset(s)
Save current dataset as
Clear dataset(s)

Create study

Load existing study
Save current study
Save current study as
Clear study

Memory and other options

History scripts

Manage plugins > | i i I
. Manage data processi i ]
l Quit \ Manage deactivated plu

ICA

32



Remove line noise (Cleanline)

B CleanLine Options

Change sampling rate

Filter the data »
Re-reference

Interpolate electrodes

Reject continuous data by eye

Extract epochs : ' : Channels
Remove baseline : : : 1 "1:66'

Run ICA - anathifse | C4D
Remove components ' ‘ : - 55 -o-

Automatic channel rejection

Automatic epoch rejection

v

Reject data epochs
Reject data using ICA »

Locate dipoles using DIPFIT 2.x »
Peak detection using EEG toolbox

nﬂnnH

FMRIB Tools »
Locate dipoles using LORETA »
CleanLine
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Plot channel spectra

Channel locations

Channel data (scroll)

Channel spectra and maps
Channel properties

Channel ERP image
Channel ERPs
ERP map series

Sum/Compare ERPs

Component activations (scroll)
Component spectra and maps
Component maps

Component properties
Component ERP image

Component ERPs

Sum/Compare comp. ERPs

B conmrrporeierorzel 1

reqrange 2 1)
Cancel | Ok

Data statistics

Time-frequency transforms
Cluster dataset ICs
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'\ '*~ "' -4!

0.5 Hz high-pass filter

Filter comparisons

0.5 Hz high-pass filter

50 Hz low-pass filter

0.5 Hz high-pass filter
Cleanline

r- pop_prop() - Channel 31 properties : pa— @M i pop_prop() - Channel 31 properties E=NAC - pop_prop() - Channel 31 properties a— E@Ig
File Edit View Inset Tools Desktop Window Help File Edit View Inset Tools Desktop Window Help File Edit View Inset Tools Desktop Window Help =
A I EEY PN E ) AL I EEY P EI ) Dode [ MRAVPEL- (S 0B |nDO

Channel 31 Continous data Channel 31 Continous data Channel 31 Continous data
T T— o 39.4 - - 378 s - 38.6
e “oia| Mat ~ | Mo : = ss] 193
" bl i o al i, o i
i S e T R diey g ] © e TS e i)
TE 100 kst et o e S vt |0 TE 100 [ERwas e e 2 100 = = S AoeeS g T, 0
= s s o [ - = - s - 1
197 | N R 18.9 | : -19.3
e S ¢ e o 3 5
= hly 394 [—— s = E e e R S I 386
100 200 300 400 00 200 300 400 ° 100 200 300 400
. Frames Frames Frames
< Activity power spectrum < Activity power spectrum ~ Activity power spectrum
i < | T 201 | =
o o~ o
3 10 > oh é 10
' (=) ~ = |
o Qb o o ok
2 S 20t o
| 2 =) =)
5 -10+ E 40} = -10+
g . . . L % ! L I I % L I I I
o 20 40 60 80 o 20 40 60 80 & 20 40 60 80
Frequency (Hz) Frequency (Hz) Frequency (Hz)
A = S
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Scroll channel data

| .
3

S v"d
)‘Z,

ﬁ EEGLAB v11.0.5.4bﬁu Scroll channel activities -- eegplot() A 1)

Figure Displa Settings  Hel N
File Edit Tools Plot] Study  Datase J Py J :
#3: Simd Channel locationg M
= Norm |
‘ Channel data (scr| _ _ - = _ _
Filename: Channel spectra g e o e e e O e o i P e P e e e R o e
Channels Channel propertis e A e
B e T e e S t]
. WWWMWMM
Frames per Channel ERP ima i Yo S A o e A o A A L A e o i A
M-H"-'_. N A“M,.w«—"” ", - P ~- e g o e e A N g N i e e e e e A g ol it AN At B iy A e IR i Pt P A
Epochs Channel ERPs |l S e A B o e Y2 S B e e AS
e T ¥ v S A e pniiiy i S/ i T B r e a A, N R
Events ERE e e e e e £ A A P I L L rev s oy
Sampling ra R I L R e Y S 0 e e RO S S T
ping Sum/Compare ER ey e sy e e e ey
Epoch start i ‘ e e e e
- - e i e T s, Yo e A T e i T T Y i
Epoch end ( Component activ :%WMWWW e AL
- e e A e Y i el s Pt sy ool A e p s e e o O A e
Reference Component spec|y Emwmmwwmmmww““w
-WWMMWW"M
Channel loc Component map; R e e I e s SO s s
. AN A a7 A SNRAS Lt e, TSSOV e 2 S P A, e i P et s 0 Y B febam Wit AP v v e
lCA we'ghts Com onent prop| PV e e Ayt s e el S Ml vmvivus e e sl 7 iy ot et o e e
i : Pi e R e e e A e Sy Ao e T A e
: e PR e U il A W, Py S g 8 A i Pl S o s Pl Ao P /o
Dataset siz¢ Component ERP e S A ot o PR S O oS e e AN
Component ERPs e e e S B e e e e S
o AP AT A A — et AP e M e o P ot et o e e e L e AN et e et
. P L ;AAWWMWW gt " AT S Ay oo S i A YT NP VA WAV Scale
Sum/Compare cd B T v e e A o e oy e Ay S s 45
. o = e e i e
Data statistics A e— r - & _+
. 90 91 92 93 94 95 I
Time-frequency t
Cl + d t tIC Chan' Time Value +
uster datase L' CANCELl Eventtypes| =2y '<|| 90 |15 35| Fol 935349 12568 | 4 ] : REJECT |

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA 36



Scroll channel data

n Scroll channel activities -- eegplot() [ ) =N X

Figure Display |Settings| Help N

Event markers Stack

= Norm

1
1
2
1
1

channels,
time,
events

‘ ' |

sec/epoch

5

e e o Ao TN B e oo Scroll

e e e e e n e s | buttons

‘ |

ISR RENSESEEEEEERFENSEEESARAS LARLSELARSENS
i
":

_n
CRENEES
il }

F A e P g A IONA N i N Al N Wb N NN\ At Aty bt N N e P i A N e o b WWWMWMMMW Scale

:m%

2
|
i
f

%
b g
%3
|
|

(L=
o
(=]
-
w0
N
[{=]
o
O
SN
w0
o
——am

Chan. Time Value =i

CANCEL| Eventtvpe8| | 90 )E=I =21 Fp1 935349 12558 45 ) oy

REJECT
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|

N

Pre-processing pipeline

Collect high-density

| into EEGLAB
EEG data (>30 chan) — / mport into EEG

Import event markers

— / and channel locations

Re-reference/ ‘

down-sample High pass filter
(if necessary) —/ (~.5-1Hz) — /
( STOP! )

Save your dataset
J here; if you epoch

Remove line noise
(if necessary)

before ICA you can
import ICA weights to

Identify/reject K this dataset later )
bad channels o / time points — /

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA
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Data Cleaning for ICA

Variant 1: Continuous Data
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA
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Retrieve or reload continuous EEG dataset

GLAB v11.0.5.4b
|l File | Edit Tools Plot Study
!

EEGLAB v11.0.5.4b

Dataset 1:SimpleOddball hipass0.5 CL
Dataset 2:SimpleOddball nontargets rej
v Dataset 3:SimpleOddball targets rej
Select multiple datasets Export > tdate
, Load existing dataset :
Save current dataset(s)

Import data ra

Import epoch info »

Import event info » 0ad =

Save current dataset as V' (CC 10UIS
Clear dataset(s) )" (add/edit datase
Create study > B

Load existing study
Save current study
Save current study as
Clear study

Memory and other options
History scripts

Quit
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Manually identifying bad channels
e

n Scroll channel activities --

Figure Display Settings Help N

1) Identify bad channel

g Scale
‘: R AT i T i T I e Y e Oy e -
' : : : —_
450 451 452 453 454
Chan. Time Value
EAteEr EYEIELYpES | << | N 449 ;l >> | o 451.0988 36619 35 = REJECT

| - |
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Manually identifying bad channels

Bl ccGLAB V110540 | ——————————— ]

File Edit Tools | Plot | Study Datasets Help
_#3: SimF Channel locations
Channel data (scroll)
Filename: n Channel spectra and maps
Channels p¢ Channel properties
Frames per Channel ERP image
Epochs Channel ERPs
Eventsf ERP map series
g[a):.‘cpl':";tga:ta Sum/Compare ERPs
Epoch end { Component activations (scroll)
Reference Component spectra and maps
Channel loc Component maps
ICA weights Component properties
Dataset siz¢ Component ERP image

Component ERPs

Sum/Compare comp. ERPs
Data statistics

Time-frequency transforms

Channel spectra and maps -- pgg_spectopoo

(=[O b

Epoch time range to analyze [min_ms max_ms]:
Percent data to sample (1 to 100):

Frequencies to plot as scalp maps (Hz):

Plotting frequency range [lo_Hz hi_Hz]:

Spectral and scalp map options (see topoplot):

Help |

0 333996.0938
100
6 10 22 60
280

‘electrodes’,off

Cancel

ok |

[

EEGLABSORERDIS XX, Sept 2-5

u Figure 2: spectopo()

File Edit View

Ddde |k

Insert Tools

»

»

RRODE A B
10.0

Desktop Window Help

0&
22.0

oo

3

Ni=a
o W T e i
B "

T P

- s e e =

43



py .

3 v

&

x”'/
=

Manually identifying bad channels

BT EEGLAB v11.0.5.20 e — () |

u Component properties - po;; _p;;>p0

#3: Simg

Filename: n Channel spectra and maps
Channels p- Channel properties
L rmrne v — .'I
Eramrels per Chay u pop_prop() - Channel 3 properties @M
EPOCt = Chan [ Fie Edit View Inset Tools Desktop Window Help N
Sl ERP _
Sampllng ra Sum Channel 3 Continous data 172
Epoch start \
Epochend( oM 1861
Reference Conm = o I
Channel loc Com =
ICA weights Com -1861
Dataset siz¢ Conll ] M 37
‘ 100 200 300 400
Com Frames
Sum i Activity power spectrum
Data sz; 50 '
Time: 0)9 40+ i
Clus *2
S 30t
g 20k | . . . .
1 10 20 30 40 50
" Frequency (Hz)
EEGLAB Worlkstelp X x N8l 2 5 As6em| S| £nJizsdl Jdh

File Edit Tools | Plot | Study Datasets Help N

Channel locations » l

Channel data (scroll)

Help |

Channel index(ices) to plot:
Spectral options (see spectopo() help):

3,31
freqrange’, [2 50]

Cancel |

Ok |

u pop_prop() - Channel 31 properties

= |

File

v &eanset] Pre)fﬁ&i&éssilﬁ,‘i@

Power 10*log, ((1V*/Hz)

Edit View Insert Tools Desktop Window Help

Channel 31 Continous data
— : ‘38.6
.'ﬁ 193
R o
}_ .
= — | [-193
— 0 200 w0 a0 O
Frames
Activity power spectrum
10
0 L
-10 | | | | |
10 20 30 40 50
Frequency (Hz)
HELP | oK |




Auto-detection of noisy channels

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes

Reject continuous data by eye
Extract epochs

Remove baseline

RunICA

Remove components

Automatic channel rejection

Automatic epoch rejection

1:71
Probability Rd

_ Cancel | Hep | ok |

Reject data epochs
Reject data using ICA

Locate dipoles using DIPFIT 2.x

Peak detection using EEG toolbox

FMRIB Tools »
Locate dipoles using LORETA  »
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Auto-detected noisy channel

S VJ{
‘?,

n Scroll component activities -

Figure Display Settings Help N

g Scale
3 WMWWWWWMMWWWWWW
‘= WW%WWMWWWWAW 35
i I i .
450 451 452 453 454
Chan. Time Value

+
CANCEL | << | < | 449 > | == | P8 4521146 26647 35 _|| REJECT
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Removing channel(s)

(=) X

. 4

Event fields
Event values .
About this dataset |
Channel locations
Select data
Select data using €
Select epochs or e

E=AIE X l’

|

removeth |f not checked, will result

in dataset with one channel
——

Copy current datas
Append datasets
Delete dataset(s)

Visually edit events

F6

T e

SimpleOddball hipass0.5 CL - F6 Edit description
Browse

EEGLAB Workshop XX, Sept 2-5, 2015, Strerie

(= E ]




Removing channel(s)

You may prefer to interpolate bad channels rather than
remove them altogether

The loss in dimensionality will affect the ICA
decomposition

Usual solution:

— Delete the bad channels before running ICA

— STUDY tools will do much of this automatically (interpolate
missing channels, etc)
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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Reject continuous data

Equivalent

Plot Study Datasets Help
~ Channel locations

Channel data (scroll)
Channel spectra and maps
Channel properties
Channel ERP image
Channel ERPs

ERP map series

Sum/Compare ERPs

Component activations (scroll)
Component spectra and maps
Component maps »
Component properties
Component ERP image
Component ERPs 4
Sum/Compare comp. ERPs

Data statistics

Time-frequency transforms
Cluster datasetICs

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes

Reject continuous data by eye
Extract epochs

Remove baseline

Run ICA

Remove components

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

Locate dipoles using DIPFIT 2.x
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Scale
35
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1

5

REJECT

540
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35
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Value
48773

539

Time
539.9355

Chan.
FCE

538
|l =

Click and drag with mouse
over noisy data to reject

Reject continuous data
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5
w
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Rejecting data for ICA

y I

N
\32"

To prepare data for ICA:
Reject large muscle or

) Scroll channel activities -- eegplot() n
otherwise strange events...
B B e A A 0T Y e VA h N P S gt R e u e ct
S0 [ AU e e WA U Pt b NN L st i o WWMMWWW»’MM/ j
]| PPRRPRRIPUI IO SR SIS R R L T R NS SN PRNE S R WP %
K o04 WWWWWW‘WN\WW kT A Y P T LR R et A BT P
07 NWMWWWM’W%W WJ\M m
«09 MWMWW VIV WY PR EEe MR N S N B A
e10 WMWM&W%WWWWW 0
el mmWWWWWMWWWWWJ » ”MM
12 -y QWWWWWW IR e NNAA st e w PIRVLATENY
e13 R s ANt AP st Py “"’“‘“WWMWM
eld Ty Wy W%WWWMWWWM
el5 WWWN > memﬁw%w MWWMW%W”WMWWW
elb WWNMM%W NPPIIP IV Y AVEN (R MWWMWW%WMWWM
817 WWMMWWNMM%WWWWAKWWW
18 frerms sy e N I N WWMWM%WMWWWWK\WWWWm
€20 front g T WWWWW%MWWWWW Py Aﬁ«rm
21 oAt LUV WW%NMWNWMWWWWWMWWM
&2 WWWWWW“WMWWMWMWWWWWWMMWWWWM
€23 [ S A g P aroas g e At A MWMMWWWWWMWWM
25 MWMMWWMwWM%MMWW%MM%WW
226 WWWMMMWW%M&WWWWW /JWMMWWW
27 R I B o e RS s WP B SRR VTR
28 W%WWWM%WWWWWWWWM
b t k t t d Y VLV VA NI WMWW%WVMWWWW A WWM Scal
mem u eep S ereo ype B R O e g A W WWM
. . - N A s e MWWNWWM 10
artifacts (like eye blinks) ~——i———prmallo o St -
e e 3 s e o e 0 w1 502
CANCEL ‘ Evert types | = ;I 490 ;I == e01 5023519 87 100 ;I REJECT
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Fast (but sloppy) artifact rejection

u Scroll channel activities -- eegplot()

Figure Display [Settings] Help

Time range to display

Number of channels to display r —
indo.. Ll o[ S
Channel labels > u Chapgewindo
Zoom off/on > :
New window length (s):

Events 4

30

Help | Cancel| Ok |

D
v,
L
0
v
0
D
.
S
5
2"
A
=
»
)
L)

"‘l: -

»
W |
<o,

i Y A

Lo ey c

0 1 2 3 4

Chan. Time Value =

Spread

Denorm

I

Scale

CANCELl Eventtypesl < =l o | == 3.0082 1) | et REJECT
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Fast (but sloppy) artifact rejection

u Scroll channel activities -- eegplot()
Figure Display Settings Help N
Spread
Denorm
{ |
Il
‘ |
: |
.‘sl | 'ﬂ-.".
. R
¢ g
} '.J |
|/
: 1R ]
“ | i ; Scale
M L
JB C 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 i r
30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60
Chan. Time  Value |
= == 42 2626 1 = REJECT
Sheffie A —d = T i 2 ——]

4




Data Cleaning for ICA

Variant 2. Epoched Data

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA

55



Visualizing ERPs
-

N e o

2
\\(_7

« Epoch data according to different event types
* Reject epochs containing artifact
* Various plot types (channel and scalp topography)
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Extract epochs

- P — — L —
EGLAE 0.5.4b =l X
. \ v‘ m.. -

File Edit | Tools | Plot Study Datasets Help a

>> eeg_eventtypes (EEG)
1 140
2 60
201 60

Change sampling rate

Filter the data »
Re-reference
Interpolate electrodes
Reject continuous data by eye
Extract epochs
Remove baseline
Run ICA

Remove components

Automatic channel rejection

Automatic epoch rejection

Reject data epochs »
Reject data using ICA 4

|
- Extract data epochs - pop_epoch()

Locate dipoles using DIPFIT 2.x »
Peak detection using EEG toolbox

FMRIB Tools »
Locate dipoles using LORETA »

CleanLine

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Tversen— Preproéessmg, [CA
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Extract epochs
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Select a subset of epochs

(=JE0 X

File [Edit| Tools Plot Suucy Datasets Help
| Dataset info
Event fields
Event values
About this dataset
Channel locations
Select data
Select data using events
Select epochs or events
Copy current dataset
Append datasets
Deletq=—

Select eve
Visualle———

‘0’ because the subject |
did not miss any targets

No description

B

No description
No description

B

E

B
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| - -

SimpleOddball target epochs Edit description
Browse

‘Do not overwrite
]
current dataset ok |

Save dataset (optional)

e 4 . -
File Datasets  Help © S5 [sarch A

ile | Edit Tools Plot Study
.J_j Organize ¥ = ws v B New Folder ?

|

Import data »

~

Import epoch info » Favorite Links | Name ‘ Date modified Type
. || faces_3.set 11/11/2013 4:21 PM  SET File
> g D t: =

LERLEIELE R°°"m:' ’ [ faces 4.set 11/11/2013 421 PM  SET File
Export LJES SR EE || SimpleOddball.set 11/13/2013 715 AM  SET File |

. B Desktop || SimpleOddball_cont_r... 11/14/20139:57 PM  SET File
Load existing dataset % Computer [ stem_125Hz.set 11/11/2013417PM  SET File
Save current dataset(s) ‘| & Recently Changed
Save current dataset as Pictures “

B Music
Clear dataset(s)
IB Searches
Create study » Ji Public
Load existing study o Alm - ' ’
Save current study
- . File name: SimpleOddball_target_epochs -
ave current study as
Ea— ! Save astype: | ("set) v
ear stu
- : @ -

Memory and other options | Hide Folders [ save | [ cance |
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Scroll (epoched) channel data

B EEGLAE v11.0.5.40 R ] )

File Edit Tools | Plot | Study Datasets Help N
#3: SimF Channel loca B Scroll channel activities -- eegplot() ; L =RICHL X
Channel dat Figure Display Settings Help k]
Filename: nf ~ Channel spe
Stack
Channels p¢ Channel pro |
= = = = = Norm |
Frames per Channel ERP ~ 84 ~ 8> ~ 8 3 ~ S g ~ &g
Epochs Channel ERP = e TR T S L :
\ Events ERP map ser a i A e mm' Yy
| Sampling ra = R ey e AR o S
ping Sum/Compg s P bt %WME:M
Epoch start A3 A s S AT B e S
Component | £ R i %m% %
Epoch end ( P Ahe £ e =
RReaN = A Ty S A
Reference Compenent AN ; = % %
Channel loc Component ?‘:M % e Navtats
o T A i v el e )
- e iy o Y :§ g%ﬁ N &
ICA weights Component ﬁ%m o %W
: = e b
Dataset siz¢ Component || Emw NaE =
Component S S ) R
Sum/Comp B R A SR
el = —
A SRS A R
Data statistic z% 2 Uy
s b Ao
Time-freque el STANE W e
' AR Ry = NATARA Scale
Cluster datag TAENpSS R SR N ey S 28
Q SRt R S e ™ e
U8 Frjtemmy] e o oo -
0 250 500 0 250 500 0 250 500 0 250 500 0 250 500 I
Chan. Time  Value =
CANCEL Eventtypes| << <| 1 |z 35| 000 o000 | 28 | REJECT |
EE GLAB Works llep=2X5Sept2-5:-2645-Sheffield-England—dJdohalversen—"PreprocessingACA &




) Scroll channel activities — eegplot()
Figure Display Settings Help k]

1.1 s epoch 1.1 s epoch 1.1 s epoch 1.1 s epoch 1.1 s epoch .
Norm
S 4 . 8 3 S -
St Eot e e R S o oo e
N e T AN Y A SRR
Thowwea Do RSN,
HERe R e
i e
: LDt TN . A e
e o] oY S I
m P TN . M‘M
W el
i A e
A O T AN, . St i AL A
S Click anywhere within AR AT
m - Mw wll‘ul'
o an epoch to select it T
A for rejection N e
WVWWWWMW AR A= el e g - SR W
RN e = XY ST
EEE Ry S
S RET=vv
et e g Scal
S o ooy S
WW»&:Q N e Lo _ .l A "’* 2
) ‘ . i e i ekt gniiig 'V o) , e
0 250 500 0 250 500 0 250 500 0 250 500 0 250 500
Chan. Time Value
CANCEL Event types ‘ «< | < 1 s s Fol  886.0564 i 2 ;I | REJECT ‘
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Reject data epochs

File Edit
—#1:

Filenz
Chan
Framse
Epock
Event
Samp
Epoct
Epock
Averq
Chan
|CA w
Datas

EEGLAB v6.0b

Tools Datasets

Help

Change sampling rate

Filter the data

Re-reference

Reject continuous data by eye

Extract epochs
Remove haseline

Run ICA
Remowve components

Automatic epoch rejection
Reject data epochs
Reject data using ICA
Locate dipoles using BESA

)
4
4

Locate dipoles using DIPFIT 2.x
Laplacian

4
4

FMRIB Tools

Crand awverage datasets
Locate dipoles using LORET A
PCA plugin

v v v v

Reject data (all methods)
Reject by inspection

Reject extreme values

Reject by linear trend fvariance
Reject by probability

Reject by kurtosis

Reject by spectra

Export marks to ICA reject

Reject marked epochs
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visual
Inspection

Reject data epochs

Reject trials using data statistics - pop_rejmenu()

Scroll Data

Calc { Plot |

Calc { Plot |

Calculate |

1:31

Calculate | Scroll Data

Calc { Plot |

Show all trials marked for rejection by the measure selected above or checked below

W Abnormal trends

W Abnormal values
W Abnormal spectra

W Abnormal appearance
W Abnormal distributions

W Improbable epochs

Close (keep marks) Clear all marks Reject marked trials

‘ 64




Reject data epochs

s i el - e S —————

S i mmwwm

-rMMMMM«WWMWMMwaW

""{A’-"’-b't’k.ﬁ".‘hb‘ " A" _ i~
J\\*&u"‘\**w.\l\‘.ﬂ.ﬂﬂllﬂ‘ nh.“l\' LIV .l' H.lﬂ!lﬂ‘\

S

111111111111
000000000000
eeeeeeeeeeee

777777777777777
222222222222222
eeeeeeeeeeeeeee

Exceeds channel
standard dev. max

65

UPDATE MARKS

Value
58.8052

1543.3749

Chan,
e0l

CANCEL
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Reject data epochs

EEGLAB v6.0b

File Edit ML Plot Datasets Help N

Change sampling rate L

—#L1 —
Filter the data »
Silleie Re-reference t
Chan Reject continuous data by eye

Fram:e Extract epochs
Epoch
Event
Samp Run 1CA

Epocl  Remove components

Epoch
P Automatic epoch rejection

Aver
L‘Zhana1 Reject data epochs 4 Reject data {all methods)

Remove haseline

|CA w Reject data using ICA » Reject by inspection

Datas| | are dipoles using BESA > Reject extreme values
Locate dipoles using DIPFIT 2.x  » Reject by linear trend/variance
Laplacian » Reject by probability

FMRIE Tools Reject by kurtosis

Grand average datasets
Locate dipoles using LORETA
PCA plugin

Reject by spectra

Export marks to ICA reject

Reject marked epochs

v v v v

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA 66



py .

A
\5;

Visualize ERP in rectangular array

B EEGLAB v11.05.4b ESEEX
File Edit Tools | Plot | Study Datasets Help N =5 |
_#5: SimF Channel locations » ;j n Figure 3: plottopol) ¥ =
Channel data (scroll) File Edit View Inset Tools Desktop Window Help N
Filename: n Channel spectra.and maps Zd_] 6 H \é % '+\ ..\ -Q‘fr:'] @ -Q ’{ . @ D IE] ) @
Channels p¢ Channel properties
Frames per  Channel ERP image SimpleOddball targets rej
Epochs Channel ERPs With scalp ma 1 9 3 1
Event:-‘f ERP map series \ In scalp/rect. § PLYW A S LN o S ¥ o W NV -FLB&N -Fu-\bh %vw" 'F““ﬁ““
Eﬂﬂ';gaf SR | ] 10 11 12 3 4 5 6
Epoch end { Component activations (scroll) .Fg,b&:. ._\,G&h ...bﬂ&.‘ .,.bM... ]rv& 1'\7%- }Nﬁﬁ— }.ﬂg.._
Reference Component spectra and maps 17 18 19 0 1 2 3 4
Channel loc Component maps » ' l ...,,&,.... ..,,J\_"\g.. ""bh"" 1.‘&_. 1.,/_\&;. i,&. %&w“ %,A——
ICA weights Component properties I
: 5 16 . 17j 18 19 30 31 2
Dataset siz¢ Component ERP image %&_ Ay L ,_‘,'&__‘ %
Component ERPs L A A - < + <
o 33 34 35 6 37 36 39 40
Sum/Compare comp. ERPs | -m A e AR -m '-‘l’nﬂn‘b' 'm -J‘.&ﬁu
- Data statistics »
n Topographic ERP ;_)Iot - pop_plottopoOv i @@é " f 1 A f2! f 3 : ﬁT‘;E f SE f GE f 7E f 8 E
Channels to plot 1:66 9 50 a1 2 83 54 5 56 A
Plot title SimpleOddball nontargets rej "“9 ™ I ‘ i i | ' i
Plot single trials | (set=yes) Y £8 £9 0 61 6 3
Plot in rect. aray = Lha - o T =
Other plot options (see help) 'ydir, 1 65 66 ' ’
T T -20.1
Help | Cancel | Ok | -12_? : 9)96
ime (ms
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Visualize ERP in topographic array

py .

B EEGLAB v11.05.4b [E=EERT
File Edit Tools | Plot | Study Datasets Help N u Figure 2: pIottopoOA‘ ——
__ #5:Simp_ Channellocations d File Edit View Insert Tools Desktop Window Help ~
Ch Id Il o 5 @ D o
el a el EE IR T P A I EILT-
Filename: n Channel spectra and maps
Channels p¢ Channel properties SimpleOddball targets r%o(?ﬂ"
Frames per Channel ERP image ‘I
\ Es:r(i:\ss Channel ERPs With scalp ma HEO&- Fp Fp Fp
~ ERP map series \ In scalp/rect. g *M& 4&\&
sampingra ERP | AP AF 2*% AF o
Epoch start um/Compare ERPs AF
Epoch end ( Component activations (scroll) F7 {.I,@A [! ! %8
Reference Component spectra and maps i F3 F1 Z' 2 4 :
Channel loc Component maps 4 FT-*W- FT*AE-
' ICA Weigh_ts Component properties ' FC FC C |’ i FCJ ¥ T CJ F C
Dataset siz¢ Component ERP image ’ ’ A ‘ n: ‘ D: !'I: ’ !EC ’ E: ‘ E ‘ A ’
Component ERPs » T7 Ch C3 C1 CZ' C2 C4 C6 T8
Sum/Compare comp. ERPs ’ ﬂ ‘ “ ‘ lll
. __ Data statistics > 4.&1 PJ ; CP CP F CPJ &L‘
u Topographic ERP plot - pop_Aplottopoo. v é@lﬁ TP;‘ P ‘ f ﬁ ‘ H cp TP
Channels to plot 1:66 p7+ﬂ‘95‘ . ‘ 1 ‘ ? P4‘ PG‘ p8+A"'
Plot title SimpleOddball nontargets rej PO "ﬂ“”‘ iﬂw
o P9 PO R PO4 P1
Plot single trials || (set=yes) PO PO .
Plot in rect. array | (set=yes) 01 Oz“&W‘ o2f " ' .‘_. »
Other plot options (see help) 'ydir', 1 -20.1
-102 996
p Iz ‘i b
Help | Cancel | Ok | Mo

i
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Visualize ERP scalp distribution

ERP data and scalp maps -- pop_timtopo()

Plotting time range (ms):

Scalp map latencies (ms, NaN -> max-RMS)
Plot title:

Scalp map options (see == help topoplot):

Help |

-101.5625 996.0938
NaN
ERP data and scalp map:

e

Insert Tools Desktop Window Help
NARRODE LS| 0B D

352

n Figure 2: timtopo()
File Edit View
B EEGLAB v11.05.4b [E=REER G L
Y d =
File Edit Tools [Plot| Study Datasets Help ¥ =
#5: SimF Channel locations 4 ;j
Channel data (scroll)
Filename: n Channel spectra and maps
Channels p¢ Channel properties
Frames per Channel ERP image
Epochs Channel ERPs ‘ With scalp maps
gvent? ERP map series In scalp/rect. array
ampling ra
Sum/Compare ERPs
Epoch start - 20
Epoch end ( Component activations (scroll)
Reference Component spectra and maps —
Channel loc Component maps » ' i 1 0 |
ICA weights Component properties
Dataset siz¢ Component ERP image @©
Component ERPs » E A
Sum/Compare comp. ERPs 8 0 )
" O
Data statistics » al
Time-frequency transforms »
Cluster dataset ICs _1 0 :

00 400

0 00
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Visualize channel ERPs in 2D

u Plot ERP scalp maps in 2-D -- pop_topglozo - .__,, s lﬂl@g
Plotting ERP scalp maps at these latencies 25-25-300

(range: -102 to 996 ms, NaN -> empty):

B £EGLAB v11.05.4b Plot titte :
File Edit Tools | Plot | Study Datg Plot geomet n ik —
. File Edit View Inset Tools Desktop Window Help N
_ #4:SImE_ Channellocatigl = > Additional () (5 ([ & | b (R LD DR AL- (S (0B | =D

Channel data (3

Filename: Channel spectr|

Channels Channel prope| Help

Frames per  Channel ERP in|

Epochs Channel ERPs »

Eventsf ERP map series y

gzg::‘:lgtgarrf Sum/Compare ERPs

EpOCh end ( Component activations (scroll)

Reference Component spectra and maps

Channel loc Component maps »

ICA weights Component properties

Dataset siz¢ Component ERP image
Component ERPs il

— Sum/Compare comp. ERPs .
Data statistics PV 16.2
Time-frequency transforms » 8.1
Cluster dataset ICs 0
-8.1
-16.2
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Visualize channel ERPs in 3D

B Figure 2 - —

File Edit View Inset Tools Desktop Window Help

Iiaaum NEEY L PARIREIL ]
B EEGLAB v11.05.4b e ) S '
= . . 100 rac 120 mea 160 ms
File Edit Tools [Plot| Study Datasets Help [ [ Figure3 — — | (B
#4: SimF Channel locations File Edit View Insert Tools Desktop Window Help ~ :
Channel data (scroll) Odde ’ Iy ‘ RNE {ﬂ?@ s - ‘ @ ‘ 0& ‘ o0 *1 I
Filename: Channel spectra and maps 130 ms “g
Channels Channel properties N
Frames per Channel ERP image T T 50 ms
Epochs Channel ERPs
Events :
i ERP map series
ping r Sum/Compare ERPs
Epoch start | |t
Epoch end Component activations (scrol‘ "g
Reference Component spectra and maps
Channel loc Component maps
ICA weig Component properties 219
Dataset sizt Component ERP image | 10.9
Component ERPs ]
— Sum/Compare comp. ERPs -10.9
Data statistics -21.9
Time-frequency transforms ‘bts i
Cluster dataset ICs [l
——
o —__= I == =
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Collect high-density
EEG data (>30 chan)

Pre-processing pipeline

/ Import into EEGLAB

Import event markers
e / and channel locations

Re-reference/
down-sample
(if necessary)

High pass filter
(~.5=1Hz2)

-/

Remove line noise
(if necessary)

—/

Identify/reject
bad channels

.

#

Reject large artifact
time points

—/

—/
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File  Edit

—#1: 1

Filenz
Chan
Frame
Epock
Event
Samp
Epock
Epock
Avera
Chan
|CA w
Datas

Finally: Runica options

EEGLAB v6.0b - X Option Default Comments
Tools EE Datasets Help N
Change sampling rate L ‘extended’ 0 1 is recommended to
Filter the data » find Sub_gaussians
Re-reference t
FREISEL cantintious cisns By Bye ‘stop’ 1e-7 final weight change - stop
Extract epochs
Remove haseline ‘ ) .
Irate determined too small = too long...
from data too large - wts blow up
Remove components
Automatic epoch rejection . ,
Reject data epochs ) maxsteps 912 more channels - more steps
Reject data using ICA 4
Locate dipoles using BESA b ‘pca’ 0or Decompose only a
Locate dipoles using DIPFIT 2% » EEG.nbchan  principal data subspace
Laplacian »
FMRIE Tools » ]
Other algorithms:

Grand ave .. . . .
) = Run ICA decomposition -- pop_runica() binica,amica,sobi,acsobiro
ocate dip
PCA plugin ICA algorithm to use (click to select) runica E]J

Commandline options (See help messages) \ syl B0 TR0 —|

Channel type(s) or channel indices | .. Types | ... channels |

Cancel | Help |

Ok |
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Runica progress...

N v

- o
N,

©
"~ ST,

Press Button to interupt runica

Interupt

Online bias adjustment will be used,
Removing mean of each channel ...

Computing the sphering matrix,,.
Starting weights are the identity matrix ..,
Sphering the data ...

step 1 - lrate 0,001000, wchange 16,85061324,
step 2 - lrate 0,001000, wchange 0,26760405,
step 3 - lrate 0,001000, wchange 0,73058323,
step 4 - lrate 0,000980, wchange 0,66700031,
step 5 - lrate 0,000960, wchange 0,62843071,
step 6 - lrate 0,000941, wchange 0,73967955,
step 7 - lrate 0,000922, wchange 0,73727223,
step 8 - lrate 0,000904, wchange 0,74051387,
step 9 - lrate 0,000886, wchange 0,74536137,
step 10 - lrate 0,000868, wchange 0,72101402,
step 11 - lrate 0,000851, wchange 0,14690114,
step 12 - lrate 0,000834, wchange 0,11822100,
step 13 - lrate 0,000817, wchange 0,75552966,
step 14 - lrate 0,000801, wchange 0,26739750,
step 15 - lrate 0,000785, wchange 0,12123251,
step 16 - lrate 0,000763, wchange 0,10285606,
step 17 - lrate 0,000754, wchange 0,09770499,
itep 18 - lrate 0,000733, wchange 0,09544428,

Input data size [33,133175] = 33 channels, 133175 frames/nFinding 33 ICA components using extended ICA,
Kurtosis will be calculated initially every 1 blocks using 6000 data points,

Decomposing 122 frames per ICA weight ({1089)°2 = 133175 weights, Initial learning rate will be 0,001, block size
Learning rate will be multiplied by 0,98 whenever angledelta >= B0 deg,
More than 32 channels: default stopping weight change 1E-7
Training will end when wchange < 1le-07 or after 512 steps,

Final training data range: -171,806 to 179,094

Beginning ICA training .., first training step may be slow ...

angledelta 0,0 deg
angledelta 0,0 deg

angledelta 104,0 deq
angledelta 147.2 deg
angledelta 146.5 deg
angledelta 150,7 deq
angledelta 151,6 deg
angledelta 137.9 deg
angledelta 156,0 deq
angledelta 143,7 deg
angledelta 102.5 deg
angledelta 114,3 deg
angledelta 100,6 deg
angledelta 109,1 deg
angledelta 94,2 deg
angledelta 110,7 deg
angledelta 118.6 deg
angledelta 117.1 deg
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step 241 - lrate 0,000002, wchange 0,00000082,
step 242 - lrate 0,000001, wchange 0,00000061,
step 243 - lrate 0,000001, wchange 0,00000057,
step 244 - lrate 0,000001, wchange 0,00000054,
step 245 - lrate 0,000001, wchange 0,00000055,
step 246 - lrate 0,000001, wchange 0,00000047,
step 247 - lrate 0,000001, wchange 0,00000046,
step 248 - lrate 0,000001, wchange 0,00000045,
step 249 - lrate 0,000001, wchange 0,00000041,
step 260 - lrate 0,000001, wchange 0,00000036,
step 251 - lrate 0,000001, wchange 0,00000033,
step 252 - lrate 0,000001, wchange 0,00000029,
step 253 - lrate 0,000001, wchange 0,00000030,
step 254 - lrate 0,000001, wchange 0,00000023,
step 265 - lrate 0,000001, wchange 0,00000023,
step 256 - lrate 0,000001, wchange 0,00000023,
step 257 - lrate 0,000001, wchange 0,00000021,
step 258 - lrate 0,000001, wchange 0,00000020,
step 2589 - lrate 0,000001, wchange 0,00000019,
step 260 - lrate 0,000001, wchange 0,00000015,
step 261 - lrate 0,000001, wchange 0,00000014,
step 262 - lrate 0,000001, wchange 0,00000014,
step 263 - lrate 0,000001, wchange 0,00000013,
step 264 - lrate 0,000001, wchange 0,00000012,
step 265 - lrate 0,000001, wchange 0,00000011,
step 266 - lrate 0,000001, wchange 0,00000010,
step 267 - lrate 0,000001, wchange 0,00000010,
step 268 - lrate 0,000001, wchange 0,00000010,
step 269 - lrate 0,000001, wchange 0,00000008,
Sorting components in descending order of mean
Permuting the activation wave forms ,,,

angledelta 101,5 deq
angledelta 96,1 deg
angledelta 97,5 deg
angledelta 93,7 deg
angledelta 100,3 deg
angledelta 96,9 deg
angledelta 91,3 deg
angledelta 101,5 deg
angledelta 103,1 deq
angledelta 95,5 deg
angledelta 92,1 deg
angledelta 97.4 deg
angledelta 95,8 deg
angledelta 94,2 deq
angledelta 97,6 deg
angledelta 97,1 deg
angledelta 92,0 deg
angledelta 99,1 deq
angledelta 95,0 deg
angledelta 98,3 deg
angledelta 99,0 deg
angledelta 94,3 deg
angledelta 95,4 deg
angledelta 94,1 deq
angledelta 96,1 deg
angledelta 94,8 deg
angledelta 94,5 deg
angledelta 97,7 deg
angledelta 95,1 deg
projected variance ...

-
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Terminal

File Edit View Terminal Tabs Help

>> EEG

EEG =

setname:
filename:
filepath:
subject:
group:
condition:
session:
comments:
nbchan:
trials:
pnta:

srate:

xmin:

Xmax :

times:

data:
icaact:
icawinv:
icasphere:
icaweights:
icacnansind:
chanlocs:
urchanlocs:
chaninfo:
ref:

event:
urevent:
eventdescription:
epoch:
epochdescription:
reject:
stats:
specdata:
apecicaact:
splinefile:
icasplinefile:
dipfit:
history:
saved:

etc:

'faces_4 continuocus’
‘faces_4.set’

' /home/julie/workshop06/ "
L

L

(]
[15x48 char]

33

N = =

o

532.6960

[]

[33%x133175 single]
[23x1332175 single]
[23x33 double]
[23x33 double]
[23x33 double]
[IX33 double]
[1x23 struct]
[]

[1x1 struct]
'common !
[1x731 struct]
[1x721 struct]
(1 1}

[]

{}

[1x1 struct]
[1x1 struct]
[]

[]

[1x1 struct]
[1x16323 char]
‘o

(1

ICA weights in EEG structure

)

File Edit Yiew Insert Tools Desktop Window Help

Figure 2

DEES|h|QRQOS|(E|0EE|5 D

v

facesaconﬁnuous

12

18

24
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Exercises (optional homework)

* Preprocess data of your choice or load a
previously filtered dataset e.g. faces 4.set

* Identify bad channel(s) using auto-detection tool;
plot channel properties of flagged channels

* |dentify and remove non-task portions of
continuous data; see if the previously flagged
channels are still identified as bad

* Epoch on event of interest. Scroll the epoched
data and perform visual rejection of epochs

* Explore the automated artifact rejection tools
* Run ICA

EEGLAB Workshop XX, Sept 2-5, 2015, Sheffield, England —John Iversen— Preprocessing, ICA 76



